Quick Ceph® Systems

Creating an AppleTalk Network for Mac OS 9

This document will help you to set up a simple Macintosh network. We will only be getting into the basics of networking.
More information can be found in the Macintosh Help Center, under the Help Menu.
Ethernet Patch Cable

Equipment

Ethernet cables comes in a variety of
types. You should choose Category 5
(Cat. 5) cables with RJ-45 connectors.

Macintosh with Ethernet Port

Ethernet Hub or Switch

File Server

This computer serves as a terminal. The Ethernet port will have a
symbol identical to the one shown
to the left. Use this port to connect
the Ethernet cables to the Hub.

The hub is the central connection
between computers on a network.
Choose either a 10/100Base-T
Hub or Switch. Hubs are less
expensive, but switches provide
faster network connections.

To eliminate file duplication, we
recommended that you use a single
computer to contain all of your patient
records, and have other computers
on the network access it.
IMPORTANT: Frequently back up
your patient files.
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Setting up the Mac for AppleTalk
1

Click on the Apple menu and go to “Control
Panels” and then select “Extensions
Manager”. The screen shown to the right will
appear. Scroll downward and make sure the
following control panels and extensions are
turned on:
Control Panels
AppleTalk
File Sharing

Extensions
Apple Enet
AppleShare
File Sharing Extension
File Sharing Library
All Open Transport
All OpenTPT extensions

Click on the Apple menu and go to “Control
The
screen shown to the right will appear.

2 Panels” and then to “File Sharing”.

Type in the Owner Name and the
Computer Name. A Password can
be used, but is not necessary.
Click on this button to initialize file
sharing. The menu will change to the
following icon to indicate file sharing
is on:

The Program Linking button can be
enabled if you wish to be able to link
programs across your network.
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3

Click on the “Users & Groups” tab within the
File Sharing section. The window shown to
below will appear. Double-click on the “Guest”
option, highlighted below.

Quick Ceph® Systems

4 display the sharing options for Guests.

Click on the “Show” selection box and select “Sharing” to
Make sure this
option is checked to
allow guest users to
connect to this computer. Guest access
is much easier to
implement than
password access.
Close the guest window and the File
Sharing window
when you have
made these
changes.

5

Next, click on the Macintosh hard
drive once to select it. Then, go
to the File menu and select “Get
Info”, then “Sharing...”. The dialog box to the right will appear.

NOTE: To limit access to specific folders or to limit “Write”
access in certain folders, such
as the Patient Folder, you should
select that folder, perform “Get
Info” as described, and change
the priveleges as shown below.

Make sure you have selected the
appropriate settings and then
close this window.

The Privileges option allows you
to choose which computer has
the permission to read or write to
other computers on the network.

Click this option
to display the
networking
options shown.

Use the Copy function to allow
other computers on the network
full access to all folders contained within the hard drive.

6

Repeat steps 1 - 5 on each computer you wish to connect to the
network.

NOTE: If you are using an older
Macintosh, check to make sure
AppleTalk is set to “Ethernet”.

When these steps are finished,
you are ready to go on to the
next step, which is opening the
connection between the connected computers.

Click on the Apple menu and go to
“Control Panels” and then to
“AppleTalk”. Make sure it is set to
“Connect via: Ethernet”. Then, close
this window.
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Once you have set up the network, you are ready to open an AppleTalk connection between the connected computers.

Opening an AppleTalk Connection
1 “Chooser”.

On one of the computers, click on the Apple menu and select
A window, similar to the one shown to the right, will
appear. Click on the “AppleShare” icon.
This will bring up a menu in the right allowing you to select a
connected computer. If a computer name does not appear in
this area, then either it is not turned on or it was not connected
properly.
Double click on the name of the computer to which you wish to
connect.
(For the sake of simplicity, only one computer is shown here.)

2 that computer.

The window shown on the left will appear next with “Registered User” preselected. Click on “Guest” to easily connect to
The screen will look like the one shown to the right. Click on the “Connect” button to continue.

TIP

3 box shown to the right will appear.

After clicking on “Connect”, the dialog
This
box indicates the name of the connected hard drive.

To set the computer
so that it connects to
this hard drive upon
startup, click on the
small box to the right
of the hard drive
name.

Click on “OK” to select this hard drive.

4 the hard drive can now be accessed from the present computer, which

You will now see the hard drive icon on your desktop. This indicates that

allows you to share files between the computers.

If you make an alias of this icon and place it on your desktop, it will eliminate the need to repeat Steps 1-3.
You can now perform this procedure on the other computers connected
to the network.
http://www.quickceph.com/docs/1027Networking.pdf
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TIP

We recommend setting one computer as
the “File Server”,
which will contain all
of your patient files.
This reduces the
possibility of duplicate files.
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In order to share files with your PC, the Mac needs to be connected to a network. Windows NT 4.0 provides connectivity
between the different platforms. Listed below are the instructions for implementing this network in your office.

NOTE: These are extremely simplified instructions, and are meant to be used as a general guideline for networking.
Before starting, make sure that the NT system has been properly configured and the Macintosh computers have
been set up properly for File Sharing, as described in the previous sections.

Connecting to a Windows NT Network - PC Side
1 install the Macintosh drivers

When the “Select Network Service” window

Windows NT does not, by default,

2 appears, scroll down until “Services for

Macintosh” appears. Select this item and
click on “OK”.

needed to communicate with the
Macintosh. To do this, you will
need the Windows NT CD-ROM.
First, click on the Start button,
select “Settings”, and then
“Control Panels”.
Locate and double click on
“Network”. The window to the
right will appear. Click on the
“Services” tab to display the current NT supported protocols.
Now, click on the “Add” button.

3 you to select a source disk to copy the required files.

The computer will then open the “Windows NT Setup” window, prompting
It will look similar to
the window shown to the left.
If you are using Windows NT on an Intel machine, make sure to specify
the “i386” directory, as shown. The drive letter (“D:” in this case) specifies
from which drive the information is copied.
Click on “Continue” once the settings are correct to install the program.

5

4 has been installed,
After the software

you will be returned
to the Network dialog box. Close out
of the dialog box.
The AppleTalk properties dialog box will
appear.

Select this option.
Type in the number of computers
on the network.

The Macintosh Zone
defines a group of
connected computers, as seen by the
server. You can create a Zone by selecting “Add”. One zone
can be made the
Default zone.

Make sure the correct ethernet adapter
is selected within the
“Default Adapter”
box indicated by the
arrow.
Then, click on the
“Routing” tab, as
shown to the right.

http://www.quickceph.com/pdf_docs/1027Networking.pdf

Select the following options to enable networking.

Click on “OK” when the revisions are complete, and
restart the computer.
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The PC has now been configured to recognize the Macintosh computers connected on the network. Now, we must link the
Macintosh to the PC using AppleTalk in order to share files.

Connecting to a Windows NT Network - Mac Side
1 and select “Chooser”.

Starting with one of the Macintoshes, click on the Apple menu
A window similar to the one shown to
the right will appear. Click on the “AppleShare” icon.

PC

This will bring up a menu in the right allowing you to select a
connected PC. If the PC’s name does not appear in this area,
you should check the Mac to make sure File Sharing is turned
on. If it is, you should return to the previous section and
check if all steps were followed correctly.
Double click on the name of the computer to which you wish to
connect.

2 “Registered User” preselected.

The window shown below will appear next with
Click on “Guest” to easily
connect the computers. Then, click on the “Connect” button to continue.

3 available folder volumes on the connected PC computer.
The dialog box shown below allows you to connect to

The default volume created on the computer is labeled as
shown. Click on the name and then click on “OK.”
PC

“PC” as:

“PC”

4 on your desktop.

The PC icon representing the PC shared folder will appear
You will be able to transfer files with this
folder and treat it just as you would a connected
Macintosh.

5 any PCs connected to the network to send or receive

On the PC side, you will be able to access this folder with
files, such as digital x-rays, patient images, etc. The
default location of the folder is in the “C:” drive of the
server, which can be accessed by double-clicking on the
My Computer icon.
Information on connecting PCs to the NT network can be
found in the Microsoft user manuals.

You can now make an alias of this icon. Select the shared
folder icon by clicking once. Go to the File menu and
select “Make Alias”. To access the drive, double-click on
the alias icon. This will save you time, as it allows you to
bypass the Chooser steps when you wish to open the
shared folder.

http://www.quickceph.com/pdf_docs/1027Networking.pdf
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For simple peer to peer connections, we recommend
connecting the Macintosh to PC computers using PC
MacLAN (www.miramarsys.com). More information can
be found in the following section.
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Instructions for using PC MacLAN

PCs can also be connected to Macs via the AppleTalk protocol with a program called PC MacLAN from Miramar Systems
(www.miramarsys.com). This makes it much easier to connect the computers together and requires less administrative
work. This system is best if you are looking for a simple method of sharing your files between platforms.

NOTE: Before starting, make sure that the Macintosh computers have been set up properly for File Sharing, as shown in
the previous section.

Connecting to an AppleTalk Network - PC Side
1 almost entirely automated, so installation is simple.

Insert the PC MacLAN CD-ROM and follow the instructions listed on the software documentation to install. This process is
You should restart after the installation is complete.

2 software was been successfully installed.

During the start up process, a new PC MacLAN splash screen will appear, indicating that the
Once the computer has started up, click on the Start menu and select “Programs”. Then,
select “PC MACLAN” from the menu. You will see a menu bar which looks like the one
shown to the right. Click on “File Server”.

3 ence.

This will bring up the dialog box shown below. The options are labelled here for easy refer-

Server Settings

Users and groups

Shared Folders /
Access Priveleges

File Extension
Mappings

Server Menu
Start / Stop

Help Button

4 is initiated, the file sharing icon will change to the figure shown to the right.

To activate the file sharing on the PC, click on the “Start / Stop” button. Once the file sharing

5 station for a digital x-ray machine, go to the Start menu and select “Programs”.

If the PC is to be used only for one way transfer of files to the Macintosh, such as a capture
Then, select
“PC MACLAN” from the menu. On the menu that appears to the right, click on “Shortcut to
AppleTalk”. This will open the Network Neighborhood window (not shown).

In the Network Neighborhood window, you will see an icon for the connected Macintosh computer. To connect to this computer, double click on the icon. The connection process is similar to the one shown on page 5 of this document.
NOTE: If you wish to send files from the Macintosh to your Windows PC, please follow the
instructions on the following page.
http://www.quickceph.com/pdf_docs/1027Networking.pdf
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Instructions for using PC MacLAN (Cont.)

The following steps set the PC as a file server, allowing you to upload picture files from the Mac. The information presented below assumes that Steps 1-5 on the previous page have been completed.

Connecting to an AppleTalk Network - PC Side
1 ate the folders you wish to be viewable by the Mac.

Click on the Shared Folders button, shown to the right, to select or creTo navigate, you can click on the “C:\” drive in the top window. For simplicity, we
will select the “C:\” directory as the shared directory, although you can create
your own shared directory
Click on the “Share” button, circled on the right image, to continue. The window
shown below will appear.

2

Name the shared folder.
Set the “Priveleges” as
shown to allow all users
to both read and write
to the selected folder.

NOTE: The “Priveleges” section allows you to control access for users who log onto the computer.
The settings shown allow for full access to read and
write to this folder. Functionality can be disabled by
unchecking these options. For example, to limit
access and allow users to read only, you should
unclick the option, “Make changes” for “Everyone”.

Selecting this option
allows you to access all
folders within the current shared folder.

Click on “OK” when all necessary options are checked. This will allow the Macintosh to connect to the PC and grab files.

Connecting to an AppleTalk Network - Mac Side
1

To connect to the PC using the Mac, first click on the Apple menu, then select the Chooser.
Select AppleShare, then double-click on the appropriate file server. In this case, it is the “PCMACLAN PC” server. A file
sharing window wil appear, as shown below. Select “Guest” and click on the “Connect” button.

2 connection screen shown below, allowing you to

Clicking on the “Connect” button will bring up the
choose the shared hard drive.

PCMACLAN PC

PCMACLAN PC
Drive C

“PCMACLAN PC” as:

“PCMACLAN PC” as:

Click on the
“Guest” button for
simpler access.
http://www.quickceph.com/pdf_docs/1027Networking.pdf

3 drive.

Click on the “OK” button to connect to the PC hard
A new icon representing the PC hard drive
will appear on your desktop. You
can now share files with your PC.
For more information about using PCMACLAN,
please visit the Miramar Systems site at www.miramarsys.com.
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